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Support
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Chapter 1
Introducing the Smart Plug-in for 
Exchange

This chapter introduces you to some basic Smart Plug-in for Microsoft® 
Exchange Server (Exchange SPI) concepts and offers an overview of the 
components that appear in the OpenView for Windows console when 
Exchange SPI is installed. The chapter includes the following sections: 

• What the Exchange SPI does

• How the Exchange SPI works with OpenView Operations for Windows

• Service Discovery, Service Maps and Views

• Policy setup, display and deployment

• Introducing Exchange SPI reports and graphs

What the Exchange SPI does

The Exchange SPI adds Exchange 2003, Exchange 2000 and Exchange 5.5 
server-monitoring capabilities to OpenView Operations for Windows. It 
provides mission critical monitoring and management of the enterprise 
Exchange environment through predefined yet customizable policies, 
monitored message delivery times, and predefined service level reporting.
9



What the Exchange SPI does
With the Exchange SPI configured and deployed to Exchange server systems 
you will find that you can increase Exchange availability and performance, 
lower the support costs associated with the Exchange service, and improve 
capacity management and planning.

After setup, the Exchange SPI will monitor critical Exchange application/
database resources including:

• Process Monitor (for monitoring the amount of CPU time being used by 
core Exchange processes)

• Inactive Process Monitor (for monitoring core MS Exchange process for 
activity and status)

• Exchange Service Monitor (for monitoring Exchange server process for 
activity levels)

• Message Transfer Agent (MTA) and Simple Mail Transfer Protocol 
(SMTP) message process data 

• MTA Work Queue and SMTP Queues

• IS Public Average Delivery Time

• IS Private Average Delivery Time

This information comes to you through the OpenView Operations console, in 
the form of service and organization maps and views, messages, alerts, reports 
and graphs.  
10



Chapter 1
How the Exchange SPI works

Like other Smart Plug-ins, the Exchange SPI collects data that is targeted 
and gathered according to rules and schedule specifications contained within 
the Exchange SPI policies. 

After selecting nodes to be managed by the Exchange SPI, service discovery 
policies discover the Exchange environment on those nodes. Through 
deploying and modifying policies you can monitor your Exchange servers 
according to your particular needs. 

Figure 1 SPI for Exchange folder located in the OVO console   

Auto Discovery and the Service Map

The Exchange SPI has an auto discovery function which discovers Exchange 
topology. The discovery process is done by service discovery Policies, which are 
automatically deployed when a node becomes an OVO managed node. 

For Exchange 5.5, the Service Discovery policy requires the User name and 
Password of a service account with special Exchange privileges. For more 
information on this type of account and how to create one, see Chapter 3, 
Exchange 5.5 user privileges.
11



How the Exchange SPI works
The Exchange environment information discovered by the service discovery 
policies is displayed in Exchange Organization Service maps, and the 
Exchange Messaging and Organization views. 

Dynamic service maps

Service maps are created from the topology discovered on your network by the 
Exchange service discovery policies. They are dynamic: they reflect the 
present time status of your Exchange environment.

In the console, display the service map in the details pane by selecting 
Services > Applications and then selecting any level of the Exchange 
organization. Your Exchange organization and its activity can be looked at 
either in the console tree or in the Service Map display. 

Figure 2 Discovered Exchange servers, in the ASMDR 
administrative group   
12



Chapter 1
Figure 3 Service Map of ASMDR administrative group servers 

Problems in the Exchange Organization are indicated in the Service Map and 
console tree by colors that illustrate severity level. They are also indicated by 
critical, major, minor or warning messages displayed in the Message Browser. 
Hovering the cursor over any entry in the message browser will display 
descriptive details. Double-click a message to see details.
13



How the Exchange SPI works
Figure 4 Partial view of Active Message Browser, for the Exchange 
ASMDR administrative group  

The buttons in the OpenView toolbar give you easy access to the various ways 
of viewing Exchange activity: 

From left to right: Impacted Services, Root Cause, Service Map, Active 
Message Browser, Acknowledged Message Browser.
14



Chapter 1
Figure 5 Impacted Services from a server problem  

The Impacted Services service map view helps you to see at a glance the nodes 
or services that are affected by any occurrence on a node or service. 
15



How the Exchange SPI works
Figure 6 Root Cause view of an Exchange 5.5 site problem  

The Root Cause service view helps you to see the source of a problem. Root 
cause analysis starts at the level of your selected node or service, stops at the 
level where the cause of the problem lies, and draws a map that shows the 
source of the problem and the nodes or services affected by it.

Exchange Organization

After Exchange topology is discovered, the organization of your Exchange 
environment is available for display in the console tree, the dynamic service 
maps and the snapshot service views. The Exchange organization in an 
enterprise can be extremely complex, these views help in visualizing the 
organization from the overview down to the details.
16



Chapter 1
Figure 7 Hierarchical View of Exchange Organization  
17



How the Exchange SPI works
Snapshot views of the Exchange environment

To see the Exchange Messaging View or Organizational View:

1 Open the SPI for Exchange folder on the console tree. 

2 Select the Exchange version: Exchange 5.5, or Exchange 2000 and 2003.

3 Select either the Messaging View or Organizational View.

Figure 8 Location on console tree of Exchange SPI views 

These views show information about the Exchange environment collected 
during the discovery process. They make it easy to see at a glance an overview 
of the relationship between the different Exchange components in your 
Exchange organization.
18
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Messaging View

The Messaging View gives a view of the Exchange organization, showing all 
Exchange routing groups and their associated one-way connectors. Using this 
view one can quickly see how mail flows through the organization.

This icon represents Exchange connectors in the Exchange organization:

This icon represents Exchange routing groups in the Exchange organization:

The arrows denote the direction of mailflow.

Figure 9 SPI for Exchange Messaging View   
19



How the Exchange SPI works
Organizational View

This hierarchical view shows your Exchange Organization sites or 
administrative/routing groups along with servers.

This icon represents the servers (2000/2003 or 5.5):

This icon represents the Exchange 2000 administrative groups: 

This icon represents the Exchange 5.5 routing groups:

Figure 10  SPI for Exchange Organizational View 
20
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Messages

Policies generate messages and alerts that are displayed in the OpenView 
message browser. They are also forwarded to the appropriate service category 
and are displayed in the Service Maps. 

Double-click messages in the message browser to view the details of any 
message:

Figure 11  Selecting a Warning message in the active message 
browser 
21



How the Exchange SPI works
Messages include suggestions for corrective actions, and links to appropriate 
Microsoft information sites.

Figure 12  Message Properties with explanatory text
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Figure 13 Link takes you to appropriate Microsoft knowledge base 
23



How the Exchange SPI works
Policy setup and deployment 

Exchange SPI policies are organized in the following categories: 

• There is an EXSPI Discovery policy group for Exchange 2000 and 2003, 
and one for Exchange 5.5. These policy groups contain Exchange Service 
Discovery and Check Discovery policies. These policies perform the 
Exchange service discovery on all OVO managed Exchange servers, and 
check for service discovery errors. The service discovery policies for 
Exchange 2000 and 2003 are deployed automatically to all nodes once they 
become managed by OVO. For Exchange 5.5, the EXSPI-5.5 Exchange 
Service Discovery policy needs to be edited to include the User name 
and Password of a service account with special Exchange privileges. For 
more details on this type of account, see “Service account with special 
Exchange privileges” on page 47.

• There is an EXSPI Quick Start policy group for Exchange 2000 and 
2003, and one for Exchange 5.5. These policy groups contain the basic 
policies for monitoring Exchange servers that most administrators will 
wish to deploy, for example, policies to monitor key Exchange services, 
forward application errors and warnings, and monitor messaging queues. 
These policies need no special customization to run and are deployed 
automatically to all nodes once they become managed by OVO. 

• The EXSPI Add-Ons policy group contains policies that monitor 
applications compatible with, but not a part of Exchange, such as cc:Mail 
and Chat. They are available to select, modify and deploy as needed. 

• The EXSPI Advanced policy group contains Reporter policies, Event Log 
Warnings and Information policies and End-to-End Message Ping policies. 
Once deployed to the Exchange server nodes, Advanced policies enable the 
Exchange SPI to target specific data and measure this data against 
predefined rules, and generate actions, reports and graphs. For Exchange 
5.5 most Advanced policies require additional configuration.

EXSPI policies should not be deployed to non-Exchange systems.
24
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Policy display

Exchange SPI policies are displayed in the OVO console in two places: by 
group under the Policy groups folder, and by type under the Policies 
grouped by type folder. These groupings are for your convenience, See the 
Exchange SPI on-line Help for detailed information on policy groups, policy 
types, and policy prerequisites.

Figure 14  Console tree showing Policy groups and Policies grouped 
by type   
25



How the Exchange SPI works
Policy groups

Under Policy Groups policies are organized according to how you might want 
to deploy them. The EXSPI Discovery and EXSPI Quick Start policy groups 
contain policies that deploy automatically to nodes as soon as the nodes 
become managed by OVO, and contain most of the policies you need to get 
started. The EXSPI Add-Ons policy groups contain policies that monitor 
applications compatible with but not a part of Exchange, such as cc:Mail and 
Chat. The EXSPI Advanced policy groups contain policies that require some 
advanced configuration, including the creation of a mailbox, and in the case of 
Exchange 5.5, the creation of a service account with special Exchange 
privileges. 

Figure 15  Exchange SPI Policy groups on the console tree 
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Policies grouped by type

Policies grouped by type displays policies organized according to their 
function, for example, you can find data collection scheduling in Scheduled 
Task policies; threshold settings in Measurement Threshold policies, etc. 
Further information on policy types is available in the OVO on-line Help.

Figure 16  Measurement Threshold policies displayed in the details 
pane   
27



How the Exchange SPI works
Using Exchange SPI tools

There are two groups of Exchange SPI tools: Tools > SPI for Exchange > 
Exchange 5.5, and Tools > SPI for Exchange > Exchange 2000 and 2003. 

For Exchange 5.5 the following tools are available:

Figure 17 Exchange SPI Tools for Exchange 5.5   

• The Exchange SPI MBOX Config tool starts the mailbox configuration 
program that automatically configures a mailbox. The user name and 
password of a service account with Exchange administrative privileges 
needs to be given for the tool to execute.

• Trace On/ Tracing Off enables or disables tracing. The default setting is 
off. Tracing is generally used for troubleshooting purposes.

For Exchange 2000/2003 the following tools are available:
28



Chapter 1
Figure 18 Exchange SPI Tools for Exchange 2000 and 2003   

• Enable Message Tracking (for Exchange 2000 and 2003 only): Enables 
message tracking on Exchange 2000 and Exchange 2003 servers.

• End-to-End Configuration: This tool is a wizard for configuring the 
Ping process on Exchange 2000 and 2003 OVO managed servers.

• Exchange Cluster Configuration: This tool prints apminfo data, which 
can be used to create the apminfo.xml file used by the Exchange SPI to 
recognize clustered instances. For further information about Exchange 
SPI monitoring clusters, see “Using Exchange SPI in high availability 
environments” on page 81.

• The Exchange SPI MBOX Config tool starts the mailbox configuration 
program that automatically configures a mailbox. The user name and 
password of a service account with Exchange administrative privileges 
needs to be given for the tool to execute.

• Mount Exchange Database: This tool can search for and mount 
dismounted mailboxes or public folder store databases. For more 
information on this tool, see the Exchange SPI online help.
29



How the Exchange SPI works
• Trace On/Tracing Off tools enable or disable tracing. The default setting 
is off. Tracing is generally used for troubleshooting purposes.

OVO Foundation Tools

Some Exchange 5.5 Advanced policies require a Domain Admin account. To 
help manage those accounts, a tool called ovpmpwutil has been added to the 
OVO foundation tools. This tool is not SPI specific. Documentation for 
ovpmpwutil can be found in the Command-line Tools section of HP OpenView 
Operations for Windows on-line Help.

Exchange SPI reports and graphs

Located in the appropriate Exchange version folder under SPI for Exchange 
> Reports and Graphs > SPI for Exchange, there are a number of 
preconfigured reports and graphs, displayed by type.

Reports and graphs are enabled by the EXSPI data collection policies. 
Information is collected nightly and is then available for reports and graphs 
the following day. Some data collectors run on Saturday/Sunday only and 
therefore related reports are available only after a weekend has passed.

Please see the Exchange SPI on-line help for detailed information about each 
report, the policies that need to be deployed for each report, and 
troubleshooting information.

To display a report or graph

When a report/graph group is highlit in the console tree on the left, the list of 
reports/graphs in that group displays on the right in the details pane. Select a 
report/graph in the details pane, and double-click to open it. 

Exchange SPI reports

There are two types of Exchange SPI reports available: Summary Reports 
which show data for all servers, and Detail Reports which provide 
information server by server.
30
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Figure 19  Location of SPI for Exchange Reports on the console tree  

Reports are displayed in the console organized by type. The list of reports 
available in any category is displayed in the details pane when the category is 
selected. 

Figure 20  SPI for Exchange Conferencing reports 
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How the Exchange SPI works
Figure 21 SPI for Exchange report example   
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Exchange SPI graphs

SPI for Exchange Graphs are located in Reports and Graphs > Graphs > 
SPI for Exchange 2000/2003, or SPI for Exchange 5.5.

Figure 22 SPI for Exchange 2000/2003 groups of graphs   
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How the Exchange SPI works
Figure 23 SPI for Exchange Messaging graphs   

Figure 24 Exchange Server Public Folder Usage graph   
34



Chapter 2
Getting started

Getting started with Exchange 5.5 servers

Task 1: Install the Exchange SPI with OpenView Operations and Performance for 
Windows 

Please see the HP OpenView Smart Plug-ins, New and Upgraded, for 
OpenView Operations/Performance for Windows Installation/Upgrade Guide 
included with the product. This guide offers a product overview as well as the 
location of the latest Exchange SPI Release Notes, which you should print and 
read before getting started. 

Task 2: When the SPI is installed, open the EXSPI-5.5 Exchange Service 
Discovery policy in the Policy Management > SPI for Exchange > 
Exchange 5.5 > EXSPI Discovery folder on the OVO console. Add the User 
name and Password of a service account with special Exchange privileges. For 
information on this type of account, and how to create one, see Chapter 3, 
Exchange 5.5 user privileges.

Task 3: Add Exchange servers to the Nodes folder

The servers whose services you want to discover and monitor must be included 
in the Nodes folder of the OVO management console. Discovered Exchange 
servers without discovered services are not managed nodes. To monitor 
servers, add them to the OVO Nodes folder now.
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Getting started with Exchange 5.5 servers
To add an Exchange server to the Nodes folder

1 In the OVO console, right-click the Nodes folder, select Configure Nodes

Figure 25 Nodes > Configure Nodes Menu  

2 In the Configure Managed Nodes dialog, drag and drop servers listed on 
the left to the OVO Nodes folder on the right. 

Figure 26 Configure Managed Nodes Dialog   
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Chapter 2
Exchange Service Discovery

The Exchange SPI implements an LDAP based Exchange topology discovery. 
The discovered topology is maintained in the OpenView namespace on the 
management server or console.

• How it works 

Exchange 5.5 topology is discovered by the EXSPI-5.5 Exchange Service 
Discovery policy, which is automatically deployed to all Windows nodes after 
they are selected to become OVO managed nodes. 

• Service Map 

The discovered Exchange organization is displayed in the OVO details pane, 
in various Service Maps.

The Organization, with the name given by the Exchange administrator, is 
located beneath the Exchange folder on the OVO console tree. The 
hierarchical structure below the organization name are folders mirroring your 
Exchange organizational structure, see the diagram “Hierarchical View of 
Exchange Organization” on page 17. In the case of OVO managed nodes, all 
services are listed by product name. 

The user ID and password of a service account with special Exchange 
privileges must be added to the EXSPI-5.5 Exchange Service Discovery policy 
before deployment. For information on this type of account, and how to create 
one, see Chapter 3, Exchange 5.5 user privileges.
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Figure 27 Exchange 5.5 Organization hierarchy, and service map

Identify Exchange servers/services

The Exchange topology is discovered by the Service Discovery policy and the 
information is visible in the folders labeled Exchange 5.5 > Services > 
Applications on the OVO console tree. By expanding this folder, you see the 
organization of your Exchange services.
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If an Exchange server is listed in the tree with no services listed under it, it is 
an unmanaged server. If you wish it to be managed by OVO, perform Task 2 
“Add Exchange servers to the Nodes folder” on page 35, now.

The SPI for Exchange folder below the Tools folder on the console tree 
contains the Messaging and Organizational View folders, see “Snapshot views 
of the Exchange environment” on page 18.

Task 4: Manual Exchange Service Discovery policy deployment, if required

After adding Exchange servers to the Nodes folder, the EXSPI Exchange 
Service Discovery policy will automatically deploy.

To perform this step manually

1 In the OVO console tree expand the folders Policy Management > 
Policy Groups > SPI for Exchange > Exchange 5.5  > EXSPI 
Discovery.

2 In the details pane select EXSPI-5.5 Exchange Service Discovery and 
right-click.

3 Select All Tasks, then Deploy On. In the dialog select the nodes you wish 
the discovery to be deployed on.

After allowing about five minutes, it will be possible to view the structure of 
Exchange services. 

Task 5: Policy deployment, as required

After discovery, the version specific policies in Quick Start are auto deployed.

Select and deploy policies in the Add-Ons and Advanced policy groups, see 
Chapter 4, Using Exchange SPI policies, reports and graphs for more details.

For Exchange 5.5, the Service Discovery policy requires the User name and 
Password of a service account with special Exchange privileges. For more 
information on this type of account and how to create one, see Chapter 3, 
Exchange 5.5 user privileges.
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Task 6: Verify installation results

1 In the OVO Manager console expand the Nodes folder.

2 Right-click the node on which to verify deployment and select View > 
Policy Inventory.
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Figure 28 Policy Inventory for a node
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Getting started with Exchange 2000 and 2003 
servers

A1 Install the HP OpenView Smart Plug-ins CD, and select the SPI for 
Exchange component.

2 In the OVO console tree select Nodes. Right-click, select Configure 
Nodes and check the nodes to manage. Wait about five minutes, as the 
following occurs on the managed nodes, without user intervention:

• The EXSPI-6.0 Exchange Service Discovery and the EXSPI 
Quick Start policies for 2000 and 2003 servers are auto-deployed to 
the newly managed nodes. The act of managing the node will cause 
these policies to be deployed.

• If Exchange is discovered on the newly managed node the Exchange 
topology is determined and stored in WMI. This topology is used to 
populate the Exchange Service Map and SPI for Exchange Views. See 
the Exchange Service Discovery section below.

• Any events that require operator action are sent to the active message 
browser and the corresponding service map nodes.

3 The SPI for Exchange policies are set up out of the box with low 
thresholds. It is suggested that the operator modify the base line that the 
SPI for Exchange policies are based on, to make it appropriate for their 
Exchange base activity. Note: Any modification to a threshold on a policy 
requires that policy is re-deployed.

4 If policies from the EXSPI Advanced policy group are desired, deploy the 
desired policies of this group to the managed node.

5 Configure the End-to-End Message Ping, see “Exchange 2000/2003: 
configuring and deploying End-to-End Message Ping” on page 118. 

6 Deploy the desired EXSPI Add-ons policies to the managed node. 
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Exchange Service Discovery

The Exchange SPI implements an LDAP based Exchange topology discovery. 
The discovered topology is maintained in the OpenView namespace on the 
management server or console.

• How it works 

Exchange 2000 and 2003 topology is discovered by the EXSPI-6.0 Exchange 
Service Discovery policy, which is automatically deployed to all Windows 
nodes after they are selected to become OVO managed nodes. 

• Service Map 

The discovered Exchange organization is displayed in the OVO details pane, 
in various Service Maps.

Figure 29  Service view of one Exchange 2000 routing group  
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The Organization, with the name given by the Exchange administrator, is 
located beneath the Exchange folder on the OVO console tree. The 
hierarchical structure below the organization name are folders mirroring your 
Exchange organizational structure. In the case of OVO managed nodes, all 
services are listed by product name. 

Identify Exchange servers/services

The Exchange topology is discovered by the Service Discovery policy and the 
information is visible in the folders labeled Exchange 6.0 > Services > 
Applications on the OVO console tree. By expanding this folder, you see the 
organization of your Exchange services.

Figure 30 Hierarchy of an Exchange organization   

If an Exchange server is listed in the tree with no services listed under it, it is 
an unmanaged server. If you wish it to be managed by OVO, perform Task 2 
“Add Exchange servers to the Nodes folder” on page 35, now.
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The SPI for Exchange folder below the Tools folder on the console tree 
contains the Messaging and Organizational View folders, see “Snapshot views 
of the Exchange environment” on page 18. 

Suggested daily tasks

Areas to be routinely monitored are: 

• The OVO message browser 

Watch for warning and critical messages or multiple alarms. Read the 
associated instruction text for recommended actions.

If too many alarms of a particular type are occurring and servers seem to 
be performing correctly, you likely need to adjust the Exchange SPI 
measurement threshold policy that is causing the alarm. See the OVO 
on-line Help for instructions on how to adjust a threshold in a policy.

• The OVO reporting and graphing functionality

When you become aware of problems with a server, use the OVO reporting 
function to display additional data, or view historical trends in graphs. 

• The Service Map, and Messaging and Organizational Views 

Use the Service Map View to see at a glance the extent of a particular 
problem indicated by a message, or its root cause, or what Services might 
be affected and perhaps interrupted. Stay on top of your Exchange 
Organization by using the Messaging and Organizational views. 
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Regarding reporting

• The Quick Start folders contain schedule policies that perform the data 
collection/logging work on the managed nodes.

• All SPI for Exchange graphs populate with data that is maintained on the 
managed node. These graphs are best viewed with 12 to 48 hours of data.

• Most SPI for Exchange reports populate with Service Reporter data after 
one day. This is due to the fact that the Service Reporter data gathering 
process needs to run at least once. Trend reports require at least three 
days of data gathered from the managed nodes. See the Exchange SPI 
on-line Help to understand which schedule policies are required to 
populate which reports. Some Advance Reporter Collection policies only 
run on Saturday/Sunday, so some reports will not have data until after a 
Saturday/Sunday collection is performed.
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Exchange 5.5 user privileges

This chapter outlines procedures for creating a service account with special 
Exchange privileges for Exchange 5.5 in a Windows NT or Windows 2000 
domain.

For Exchange 2000 and 2003, the recommended configuration for the 
Exchange SPI is: 

• running the OVO agent under the user context as Local System. 

Should this not be possible in your organization, see Appendix C for details on 
how to create a privileged service account for Exchange 2000 or 2003 nodes in 
a Windows 2000 environment.

Service account with special Exchange privileges

This type of account must be set up for the following Exchange 5.5 tools/
policies to deploy successfully:

• MBOX Config tool.

• The Service Discovery policy requires the User name and Password of this 
service account.

• Many of the policies in the Add-Ons group require the service account user 
name and password, before they can be deployed.
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• Exchange 5.5 > EXSPI Advanced > EXSPI End-to-End Message Ping > 
EXSPI-5.5 End-to-End Message Ping, schedule policy requires access to 
the mailboxes created by the tool MBOX Config.

• Exchange 5.5 > EXSPI Advanced > EXSPI Reporter Collection > all 
policies. These policies use the Mailbox created by the tool MBOX Config, 
to extract information from the public folder and mailbox tables via MAPI 
(Messaging Application Programming Interface).
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Creating a service account for Exchange 5.5 
servers

For Exchange 5.5 servers, before you can deploy the above listed policies and 
tools, you must create an account for each Windows domain where OVO 
managed Exchange servers reside. This service account enables the Exchange 
SPI to access information from the Exchange database. 

Because significant configuration details vary according to operating system 
version, detailed instructions are outlined for the following environments:

• Case 1: For Nodes running Exchange 5.5 in a Windows NT Domain (NT4/
Ex5.5)

• Case 2: For Nodes running Exchange 5.5 in a Windows 2000 Domain 
(W2k/Ex5.5)

Case 1: Exchange 5.5 nodes in a Windows NT Domain (NT4/
EX5.5)

Task 1: Create service account (NT4/EX5.5) 

1 Log on as Domain Administrator of the domain to which the Exchange 
server belongs. 

2 Select Start > Programs > Administrative Tools (common) > User 
Manager for Domain.

3 Select User > New User. In the dialog that appears create a new user as 
follows:
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Figure 31 User Manager dialog 

Remember this password; you will need it later to update Tools and 
Policies.  

Username: MSXSPI

Full Name: OVO Exchange SPI 

Description: Exchange SPI for OVO 

Password/Confirm Password: *********

You must create a service account with these privileges in each Windows domain. You 
must name the account MSXSPI. Throughout this document you will notice that the 
account is referred to as MSXSPI, which is the required user name for the service 
account.
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Figure 32 New User dialog     

4 Deselect User Must Change password at Next Logon and select 
Password Never Expires.

5 Click the Groups button to display the Group Memberships window.

This password must be entered but will not be authenticated later. 
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Figure 33 Group Memberships window

6 At the right, from the Not a member of: box select the Domain Admins 
user, click Add, and OK to close the Group Memberships window.

7 To include necessary information, click buttons in the New User window:    

8 Click Add to add this user. (If the Exchange Add Mailbox window is 
displayed, select Cancel to close it).

9 Click the Close button to close the New User window.

Profile: No User Profile should be specified.

Hours: All hours of the day and week should be allowed.

Logon To: All workstations should be specified.

Account: Should never expire/should be Global Account.
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10 From the User Manager menu bar select Policies > User Rights....

Figure 34 User Manager window

11 Check the Show Advanced User Rights checkbox.

12 From the drop-down list select Log on as a service in the Right field
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Figure 35 Selecting Log on as a service for User Rights.

13 Click the Add button to open the Add Users and Groups window.

14 Click the Show Users button.

15 Select the service account just added, click Add, then OK.
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Figure 36 Adding the new service account

16 Repeat steps 12-15 to add the Profile system performance right.

Task 2: Grant Exchange access permissions to service account (NT4/EX5.5)

In order for the service account to have access to a mailbox as well as the 
Exchange IS Public and Private databases, it must have Exchange Admin 
permissions. Use Exchange Administrator to grant these permissions at the 
site level.

1 Select Start > Program > Microsoft Exchange > Microsoft 
Exchange Administrator.

2 For each Exchange site where the affected policies are to be deployed:

a In the left pane within the tree, select <site_name>.
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b From the File menu select Properties.

c In the Properties window, select the Permission tab and click Add to 
open the Add Users and Groups window.

d Select the MSXSPI service account previously created, and click Add.

e Click OK to add the user, and close the Add Users and Groups 
window.

f Verify the user has the role of Admin.
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Figure 37 Verifying the User role

g Click OK to save the changes.
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Case 2: Exchange 5.5 nodes in a Windows 2000 domain 
(W2k/EX5.5)

Task 1: Create service account (W2k/EX5.5)

1 Log on to the system that hosts the managed node’s domain.

2 Select Start > Programs > Administrative Tools > Active Directory 
Users and Computers.

3 Expand the Active Directory of Users and Computers and right-click 
Users and select New User.

Figure 38 Selecting New User dialog
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4 In the dialog box that appears, enter a user name for the service account 
in the First Name and as the User logon name fields.  

Figure 39 New object dialog

5 In the next window, enter Password/Confirm Password for the service 
account.

6 Select Password Never Expires. Then click Next

You must create a service account with these privileges in each Windows 
domain. You must name the account MSXSPI. Throughout this document 
you will notice the account is referred to as MSXSPI, the required user name 
for the service account.
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Figure 40 Setting user privileges.

7 In the New Object dialog, deselect Create an Exchange mailbox, and 
click Next.
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Figure 41 Creating an Exchange Mailbox

8 In the next dialog, complete creating the user by clicking Finish.

9 You are now back at the Active Directory Users and Computers 
dialog. In the right pane, right-click on the user just created and select 
Properties.

10 On the service account Properties page, select the General tab. Enter 
OVO Exchange SPI in the Display name and Description fields.
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Figure 42 Properties dialog
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11 Select the Member Of tab. Click Add.
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12 In the Select Group dialog select Domain Admins from the top pane. 
Click Add, then OK.

13 The new user is now a member of the Domain Admins group. Click OK 
and exit the Active Directory Users and Computer dialog.

Figure 43 New User with new membership status  
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Task 2: Grant Exchange access permissions to service account (W2k/EX5.5)

In order for this service account to have access to a mailbox as well as the 
Exchange IS Public and Private databases, it must have certain Exchange 
Admin permissions. Use Exchange Administrator to grant these permissions 
at the site level.

1 Select Start > Program > Microsoft Exchange > Microsoft 
Exchange Administrator.

2 For each Exchange site where affected policies are to be deployed:

a In the left pane within the tree, select <site_name>.

b From the File menu select Properties.

c In the Properties window, select the Permission tab and click Add to 
open the Add Users and Groups window.

d Select the MSXSPI service account just created, and click Add.

e Click OK to add the user, and close the Add Users and Groups 
window.

f Verify the user has the role of Admin.
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Figure 44 Verifying User roles.

g Click OK to save the changes.
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Using Exchange SPI policies, reports 
and graphs

This chapter outlines procedures for: 

• Deploying the various policy groups

• Using Exchange SPI in high availability environments: clustering support

• Generating Exchange SPI reports and graphs
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Using Exchange SPI policies

• Some policies in the SPI for Exchange policy groups require that 
particular software components/services are installed on Exchange server 
systems before the deployed policies will work. 

• For many Exchange 5.5 policies, you must configure a service account with 
special Exchange privileges, see “Creating a service account for Exchange 
5.5 servers” on page 49. 

• EXSPI policies should not be deployed to non-Exchange systems.

• Regarding policy names:

— Policies for Exchange 2003 only, have the prefix EXSPI-6.5

— Policies for Exchange versions 2000, and 2000 / 2003, have the prefix 
EXSPI-6.0 

— policies for Exchange version 5.5 only, have the prefix EXSPI-5.5.

• Updating the account information (user name and password) in the 
policies can be performed using the HP OpenView Operations for 
Windows tools called ovpmpwutil. Detailed procedures for using 
ovpmpwutil can be found in the Command-line Tools section of HP 
OpenView Operations for Windows on-line Help.

Use the following tables to decide which policies you want to install. In the 
Policy Prerequisites table you can see whether or not a policy group/subgroup 
works with Exchange 5.5 and/or Exchange 2000 and/or Exchange 2003, as 
well as any required configuration. Policy Group Descriptions show you what 
type of data/functionality the policy group offers.

Important Microsoft Information on the Web: Before you deploy Exchange 
SPI policies, please refer to the Microsoft article “PRB: Performance Object Is 
Not Displayed in Performance Monitor” at this URL: http://
support.microsoft.com/support/kb/articles/Q248/9/93.ASP.

The article contains information on editing the Windows registry so that 
performance objects (tracked by Performance Monitor) are always enabled. A 
disabled performance object could cause an Exchange SPI policy to fail. By 
following the instructions in the article, you can ensure that policies are able 
to collect Exchange performance data as expected.
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Individual policy definitions are documented in the Exchange SPI on-line 
Help.

Policy Groups are located in the console tree under Policy Management > 
Policy Groups > SPI for Exchange and then the Exchange version.

Figure 45 SPI for Exchange policy location on the console tree   
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Exchange 5.5 policies

Policy group prerequisites for Exchange 5.5 

 

Policy Group/ Subgroup Required Service
Required Manual 
Configuration

EXSPI Discovery N/A • Create MSXSPI service 
account with correct 
permissions

• Modify the policy to include 
service account and password.

EXSPI Quick Start N/A N/A

EXSPI Add-Ons
EXSPI cc:Mail Connector cc:Mail Connector N/A

EXSPI Internet Mail 
Services

Internet Mail Service 
(IMS)

N/A

EXSPI Lotus Notes 
Connector

Lotus Notes Connector N/A

EXSPI News Service N/A N/A

EXSPI Advanced
EXSPI End-to-End Message 
Ping 

N/A • Create MSXSPI service 
account with correct 
permissions

• Create mailbox using MBOX 
Config tool (needs service 
account name and password)

• Configure EXSPI End-to-End 
Message Ping policy to set up 
server pairs

• Modify the policy to include 
user name and password
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Policy group descriptions for Exchange 5.5

Quick Start policies for Exchange 5.5

EXSPI Event Log Warnings 
& Information

N/A N/A

EXSPI Reporter Collection N/A • Create MSXSPI service 
account and password

• Modify policies to include user 
name and password

Policy Group/ Subgroup Required Service
Required Manual 
Configuration

Policy Subgroup Description

EXSPI Directory Service Executes alarm metrics for problems detected in the Microsoft 
Exchange Directory service.

EXSPI Event Log Errors Monitors all errors (type = Error) in the Windows System Log.

EXSPI General Data 
Collection

Contains all standard data collection policies used to feed data 
into the data collector. The collected data can be graphed or used 
to generate reports.

EXSPI Information 
Store

Executes alarm metrics for problems detected in the Exchange 
Information Store service.

EXSPI Internal Errors Open Message Interface policy for trapping EXSPI errors.

EXSPI Message 
Transfer Agent

Executes alarm metrics for problems detected in the Microsoft 
MTA service.

EXSPI Services and 
Processes

Monitors the availability of key Exchange services and processes.
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Add-Ons policies for Exchange 5.5

Advanced policies for Exchange 5.5

EXSPI Transaction Log Monitors the size in MB of the Exchange transaction logfiles as 
well as the disk space used by the files. When size increases or 
available disk space decreases to specific defined values, 
messages with warnings appear in the message browser.

Policy Subgroup Description

EXSPI cc:Mail 
Connector

Executes alarm according to cc:Mail Connector metrics. Deploy on 
all Exchange servers containing the cc:Mail Connector.

EXSPI Internet Mail 
Services

Executes alarm metrics for the problems detected in Exchange 
Internet Mail service. Deploy on all Exchange servers containing 
IMS.

EXSPI Lotus Notes 
Connector

Executes alarms for Lotus Notes Connector metrics. Deploy on all 
Exchange servers containing the Lotus Notes Connector.

EXSPI News Service Executes alarm metrics for problems detected in the Exchange 
News service. Deploy on all Exchange 5.5 servers containing the 
Exchange News service.

Policy Subgroup Description

EXSPI End-to-End 
Message Ping 

Alarms on AND collects data for the End-to-End Message Ping 
policy

EXSPI Event Log 
Warnings/Information

Monitors all warnings and information messages in the Windows 
System Log. Is not typically deployed.

EXSPI Reporter 
Collection

Feeds data into the OpenView data collector for use by OpenView 
reporter.

Policy Subgroup Description
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Exchange 2000/2003 policies

Policy group prerequisites for Exchange 2000/2003 

olicy Group / Subgroup Required Service

Required 
Manual 
Configura
tion

XSPI Discovery N/A N/A

XSPI Quick Start 
ll Policies

N/A N/A

XSPI Add-Ons
XSPI cc:Mail Connector

cc:Mail Connector N/A

XSPI Chat Service 
xchange 2000 only) 

Exchange Chat Service N/A

XSPI Conferencing Service 
xchange 2000 only) 

Exchange Conferencing Server N/A

XSPI Instant Messaging 
xchange 2000 only) 

Exchange Instant Messaging Service N/A

XSPI Exchange Interprocess 
ommunication

N/A N/A

XSPI IS Virus Scan N/A N/A

XSPI Lotus Notes Connector Lotus Notes Connector N/A

XSPI Mailbox N/A N/A

XSPI NNTP Network News Transfer Protocol N/A

XSPI Public Folder N/A N/A

XSPI Site Replication Service N/A N/A

XSPI Transaction Log N/A N/A
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Policy group descriptions for Exchange 2000/2003

Quick Start policies for Exchange 2000/2003

   

XSPI Advanced
XSPI Reporter Collection N/A N/A

XSPI Event Log Warnings & 
formation

N/A N/A

XSPI End-to-End Message Ping N/A N/A

olicy Group / Subgroup Required Service

Required 
Manual 
Configura
tion

Policy Subgroup Description

EXSPI Cluster Updates the dependencies in the service map, for all nodes which 
have a dependency on the physical node in the cluster when a 
failover occurs.

EXSPI Directory 
Service Access

The policies in this group monitor the activities and cache 
performance of the MSExchangeDSAccess component, which 
provides a central communication mechanism between Exchange 
and the Windows OS Active Directory service.

EXSPI Event Log 
Errors

Monitors all errors (type = Error) in the Windows System Log.

EXSPI General Data 
Collection

Contains all standard data collection policies used to feed data 
into the OpenView data collector. The collected data can be 
graphed or used to generate reports.

EXSPI Information 
Store

Executes alarm metrics for problems detected in the Exchange 
Information Store service.

EXSPI Internal Errors Open Message Interface policy for trapping EXSPI errors.
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EXSPI Message 
Transfer Agent

Executes alarm metrics for problems detected in the Microsoft 
MTA service.

EXSPI Services and 
Processes

Monitors the availability of key Exchange services and processes.

EXSPI SMTP Executes alarm metrics for problems detected in messages sent to 
the Simple Mail Transfer Protocol (SMTP) server.

Policy Subgroup Description
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Add-Ons policies for Exchange 2000/2003  

Policy Subgroup Description

EXSPI cc:Mail 
Connector

Executes alarm according to cc:Mail Connector metrics. Deploy on 
all Exchange servers containing the cc:Mail Connector.

EXSPI Lotus Notes 
Connector

Executes alarms for Lotus Notes Connector metrics. Deploy on all 
Exchange servers containing the Lotus Notes Connector.

EXSPI Chat Service
(for Exchange 2000 
only) 

Monitors the current client connections to the chat community, 
showing anonymous connections, authenticated connections, 
authentication failures, timeouts.

EXSPI Conferencing 
Service (for Exchange 
2000 only) 

Monitors current client connections to the server, server load for 
online data and video conferences, and CPU process time of the 
T.120 MCU (multipoint control unit) server. 

EXSPI Instant 
Messaging (for 
Exchange 2000 only)

Monitors current connections using instant messaging service, 
current subscriptions, and average processor time per instance.

EXSPI Exchange 
Interprocess 
Communication

All communication into the Information Store for the POP3, 
IMAP4, SMTP, HTTP, and NNTP protocols is handled by the 
Internet Information Service (IIS). IIS receives Internet protocol 
requests and messages, and passes these requests on to the 
Information Store. The Exchange Interprocess Communication 
(EXIPC) layer is the shared memory layer between IIS and the 
Information Store, often referred to as Epoxy. Exchange SPI 
policies monitor the performance of the two Epoxy queues: the 
Client Out Queue Length and the Store Out Queue Length.

EXSPI IS Virus Scan Exchange SPI monitors the Anti-Virus API performance counters 
and Windows Event Log informing on the possibility of a virus 
attack.

EXSPI Mailbox Monitors mailbox store space usage. Calculates the percentage of 
space used by the streaming and mailbox databases relative to the 
total volume of free space. Also checks for dismounted information 
stores. 

EXSPI NNTP Executes alarm metrics for outbound newsfeed connections that 
fail. 
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Advanced policies for Exchange 2000/2003

EXSPI Public Folder Monitors public folder space usage. Calculates the percentage of 
space used by the public folder database relative to the total 
volume of free space. Also checks for dismounted information 
stores. 

EXSPI Transaction Log Monitors the size in MB of the Exchange transaction logfiles as 
well as the disk space used by the files. When size increases or 
available disk space decreases to specific defined values, messages 
with warnings appear in the message browser. 

EXSPI Site Replication 
Service

Monitors site replication to verify that synchronization updates are 
being processed efficiently. Non-zero counters indicate that site 
replication synchronization is in process. If the values are not 
decreasing over time a problem may exist with the site replication 
service or performance of the server. High values are not 
neccessarily bad, but values not decreasing is cause for concern. 

Group: EXSPI 
Advanced
Exchange 2000/2003 Description

EXSPI End-to-End 
Message Ping 

Alarms on AND collects data for the End-to-End Message Ping 
policy

EXSPI Event Log 
Warnings/Information

Monitors all warnings and information messages in the Windows 
System Log. Is not typically deployed.

EXSPI Reporter 
Collection

Feeds data into the OpenView data collector for use by OpenView 
reporter.

Policy Subgroup Description
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Deploying EXSPI Quick Start policies

To receive any information from a managed Exchange server Quick Start 
policies must be deployed. The Quick Start policy group contains the most 
basic definitions and rules for scheduling data collecting/graphing, and for 
generating messages/alerts. This policy group is automatically deployed based 
on the results of the Exchange Service Discovery, when nodes are selected to 
be managed by OVO.

For Exchange 5.5 discovery, it is necessary to edit the EXSPI-5.5 Exchange 
Service Discovery policy to include the user name and password of a service 
account with special Exchange privileges, see Chapter 3, Exchange 5.5 user 
privileges for more information.

After Discovery, the version specific policies in the Quick Start group are 
auto deployed. To deploy this policy group manually: 

1 In the left pane of the OVO Manager console expand the Policy 
management > Policy groups folders to view policy groups.

2 Open the SPI for Exchange folder and select the correct Exchange 
version: Exchange 2000 and 2003, or Exchange 5.5. 

3 Open the appropriate Exchange folder, select the EXSPI Quick Start 
policy group, right-click and select Deploy on....

4 In the Deploy policies on... dialog select all nodes by clicking the check 
box next to Nodes, or select individual nodes by clicking the appropriate 
checkbox.
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Deploying EXSPI Add-Ons policies

EXSPI Add-ons policies monitor Exchange related services, such as Lotus 
Notes or Internet Mail Services. These policies must be manually deployed. 
Please see the section “Using Exchange SPI policies” on page 68 for 
requirements for installing specific policies in the Add-ons group. 

To deploy policies in the Add-ons group

1 In the left pane of the OVO Manager console expand the Policy 
management > Policy groups folder to view policy groups.

2 Under SPI for Exchange are Exchange 2000 and 2003, and Exchange 
5.5 folders. Double click the appropriate Exchange version to view the 
version specific Exchange SPI policy groups.

3 Double-click EXSPI Add-ons and select an add-on policy group, then 
from the group select individual policies or the entire group. Check policy 
descriptions in the details pane to verify they are the correct ones (double 
click to open and see details if necessary), right-click and select Deploy 
on....

4 In the Deploy on... dialog select all nodes by clicking the check box next to 
Nodes, or select individual nodes by clicking each appropriate checkbox.

Deploying EXSPI Advanced policies

Policies in the EXSPI Advanced policy group must be manually deployed. 
There are three subgroups of policies in the EXSPI Advanced groups:

EXSPI End-to-End Message Ping policy group 

These policies enable the Exchange SPI to test network connections between 
Exchange servers, and collect performance data on message receipt and 
delivery. 

• For Exchange 5.5: to configure and deploy the EXSPI-5.5 End-to-End 
Message Ping see the procedure outlined in “Exchange 5.5: configuring 
and deploying End-to-End Message Ping” on page 108. 
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Deploying EXSPI Advanced policies
• For Exchange 2000/2003: to configure and deploy the EXSPI-6.0 
End-to-End Message Ping policies see the procedure outlined in 
“Exchange 2000/2003: configuring and deploying End-to-End Message 
Ping” on page 118.

EXSPI Event Log Warnings and Information policy group

• The EXSPI Event Log Warnings and Information policies capture 
Windows event log text and are generally meant to be deployed for 
troubleshooting purposes.

EXSPI Reporter Collection policy group

• To deploy EXSPI Reporter Collection policies, please refer to “Using 
Exchange SPI reports and graphs” on page 92 in this manual, and the SPI 
for Exchange on-line Help for a listing of all the preconfigured reports 
offered, with detailed report descriptions, policy prerequisites for 
deployment, and troubleshooting.
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Exchange SPI Clustering support

Using Exchange SPI in high availability environments

The Exchange SPI can be configured to accommodate cluster environments 
where fail-overs allow uninterrupted Exchange availability. 

Synchronized with the cluster environment, Exchange SPI monitoring can be 
made to switch off for the failed node and switch on for the active node. 

For recognizing clustered Exchange instances, Exchange SPI relies on XML 
configuration files. These files allow the OVO agent to automatically enable 
instance monitoring on the currently active node after disabling instance 
monitoring on the inactive node.

The Exchange SPI setup for a cluster environment requires the following 
steps: 

1 Add the nodes to be managed from the OVO Console.

2 Modify, if necessary, the Exchange SPI monitoring configuration file 
included with the Exchange SPI (msexchange.apm.xml).

3 Create the clustered application configuration file (apminfo.xml) that 
associates Exchange SPI-monitored instances (Exchange virtual servers), 
with their corresponding cluster resource groups.

4 Restart the agent on the managed node.

Task 1: Add the Exchange Cluster nodes to be managed from the OVO Console.

From the Configure Managed Nodes dialog box of the OVO Console, add 
the Exchange cluster nodes to be managed. This brings about the following:

— The Exchange cluster is discovered and the service map is updated 
with the cluster topology.

— Exchange SPI instrumentation is installed on these nodes.

— Exchange SPI Quick Start policies are deployed to these nodes. 
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Task 2: Modify the Exchange SPI monitoring configuration file (if necessary)

The Exchange SPI includes a monitoring configuration file, 
(msexchange.apm.xml), which is an XML file that describes the policies that 
should be cluster-aware.

The (msexchange.apm.xml file works in conjunction with the clustered 
application configuration file (apminfo.xml) that you need to create for your 
Exchange cluster.

The purpose of the Exchange SPI msexchange.apm.xml file is to list all the 
Exchange SPI policies on the managed node, in order that these policies can 
be disabled/enabled, as appropriate, for inactive/active managed nodes. 

Task 3: Create the clustered application configuration file

Apminfo.xml is an XML file that describes the cluster instances (Exchange 
virtual servers).

Apminfo.xml, working in conjunction with the Exchange SPI monitoring 
configuration file (msexchange.apm.xml), allows you to associate Exchange 
SPI monitored instances (Exchange virtual servers) with their associating 
cluster resource groups. As a result, when a resource group is moved from one 
node in a cluster to another node in the same cluster, monitoring stops on the 
failed node and starts on the new node.

To generate the content of this file:

a Launch the Exchange SPI Exchange Cluster Configuration tool on an 
Exchange cluster node, see “Exchange Cluster Configuration tool” on 
page 84.   

b Use the generated output to construct the apminfo.xml.

The Exchange SPI msexchange.apm.xml file is normally ready to 
use with no configuring. However, if you have renamed any policies, 
you need to modify the file accordingly. The file is in the SPI for 
Exchange instrumentation directory on the management server. 
After modifying this file, you need to redeploy the SPI for Exchange 
instrumentation to the Exchange nodes that are part of the 
Exchange cluster.
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c Save the completed apminfo.xml file on each node in the cluster in 
this directory:

<installation_directory>/Installed Packages
/{790C06B4-844E-11D2-972B-080009EF8C2A}/conf/OpC/ 

Task 4: Restart the agent on the managed node

After constructing and saving apminfo.xml, stop and restart the OVO agent 
by running the following commands on each node: 

opcagt -kill
opcagt -start 

Example apminfo.xml file

The following is an example apminfo.xml file, where ExchResGroup1 and 
ExchResGroup2 are the names of the Exchange resource groups 
corresponding to EXCHVIRTSERV1 and EXCHVIRTSERV2 instances (virtual 
servers):

<?xml version="1.0" ?>
<APMClusterConfiguration>
  <Application>
    <Name>msexchange</Name>
      <Instance>
         <Name>EXCHVIRTSERV1</Name>
         <Package>ExchResGroup1</Package>
       </Instance>

<Instance>

<Name>EXCHVIRTSERV2</Name>
         <Package>ExchResGroup2</Package>
       </Instance>

  </Application>
</APMClusterConfiguration> 
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Figure 46 Example Exchange resource group   

Exchange Cluster Configuration tool

Use the Exchange Cluster Configuration tool to generate the content of the 
apminfo.xml file.

Launch this tool on an Exchange cluster node:

1 In the OVO Manager console expand the Tools > SPI for Exchange  > 
Exchange 2000 and 2003 folder.
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Figure 47 Location of Exchange Cluster Configuration tool

2 In the details pane on the right, double click the Exchange Cluster 
Configuration tool.

3 Select the Exchange cluster node the tool should launch to.
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Figure 48 Select nodes dialog

4 Select Launch to start the tool running on the selected nodes.
5 Use the generated output to construct the apminfo.xml. (Please refer to 

the section “Create the clustered application configuration file” on 
page 82). 

After constructing and saving apminfo.xml, you need to restart the agent on 
the node, using the following commands:

Opcagt -kill

Opcagt -start
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Figure 49 Example output of Cluster Configuration tool
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Data Collection on virtual servers

In order for reports and graphs to show data for any nodes, appropriate data 
collection policies need to be deployed to those nodes. See the section “Using 
Exchange SPI reports and graphs” on page 92.

Run the Enable Message Tracking tool on all nodes in the cluster before 
deploying the EXSPI 6.0 Dc-TrackLog Data policy, so that the tracking log 
reports will generate. The tool must run on the physical nodes of a cluster 
where the Exchange virtual server is running.

Seeing virtual servers in reports and graphs

The Exchange SPI will show Exchange virtual servers in reports and graphs 
as though they were physical Exchange servers.

Setting up End-to-End Message Ping on an Exchange 
Cluster

Using Exchange SPI, End-to-End Message Ping can be configured on 
Exchange clusters. 

1 Run the MBox Config tool on all nodes in the cluster. The tool must run 
on the physical nodes of a cluster where the Exchange virtual server is 
running on. This is a necessary step for configuring and deploying 
End-to-End Message Ping. 

2 Run the End-to-end Configuration (wizard) tool to add the Exchange 
virtual server to the end-to-end configuration. Exchange virtual server 
names will appear in the Source Server and Destination Server fields. 
Please see “Configuring Exchange SPI End-to-End Message Ping” on 
page 107.
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Exchange Cluster Service Map

Exchange clusters are represented in the Service Map, and Service map nodes 
will be created in the service map for each Exchange virtual server in a 
cluster. Since the cluster is properly modeled in the service map, Exchange 
SPI instrumentation and Quick Start policies are auto-deployed to all 
managed Exchange cluster nodes.

Messages for the Exchange virtual server show up under the Exchange virtual 
server name in the maps.

For the Exchange Virtual server an EXSPI service discovery hosted-on 
hierarchy is created within a Clusters container. This allows messages to be 
sent to the hosted-on hierarchy. 

This same hierarchy is also created as virtual nodes under the Exchange 
Virtual Server. A dependency is created from each Virtual Exchange Server 
virtual node to its corresponding Cluster hosted-on node. Messages and status 
will then propagate up to the correct Virtual Exchange Server virtual node.
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Figure 50  Service Map illustrating clustering support 

In the example above, there are two Virtual Exchange servers: 
EXCHVIRTSERV1 and EXCHVIRTSERV2, hosted on physical nodes 
OVRNTTC1B and OVRNTTC1A. A message is received at hosted-on service 
OVRNTTCLA:Queue, and via dependencies, status and messages are seen 
under Virtual server EXCHVIRTSERV2.
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What happens during a failover:

When a failover happens, dependencies to the failed node will be removed and 
replaced with new dependencies to the newly active node. For example, if 
EXCHVIRTSERV1 moves from OVRNTTC1B to OVRNTTC1A, the 
dependencies to OVRNTTC1B will automatically be removed and will be 
replaced with a new set of dependencies to OVRNTTC1A..

When a failover happens, messages that occurred before the failover will not 
be propagated to the virtual node

For this mechanism to work EXSPI-6.0 Exchange Cluster Discovery Event 
Log policy must be deployed (normally auto-deployed as part of the Quick 
Start policy group).
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Using Exchange SPI reports and graphs

Data collection for reports and graphs

Exchange SPI reportand graph generation requires that you complete the 
following:

• Deploy the Quick Start policy group for data collection policies (if not 
automatically deployed).

• Deploy relevant data collection policies from Add-Ons policy group, for 
example, deploy EXSPI-6.0 Dc-Instant Messaging if you are interested in 
gathering data from Instant Messaging services.

• Configure and deploy Exchange SPI Reporter Collection policies in the 
EXSPI Advanced group (deploy Mailbox policies to Mailbox servers and 
Public Folder policies to Public Folder servers).

In order to collect data for reports and graphs, the data collection schedule 
policies for any particular service need to be deployed.

All policies in the Quick Start policy group are deployed automatically after 
discovery. Data collection policies in the Add-Ons and Advanced policy groups 
need to be deployed manually.

Location of data collection policies

Quick Start policy group (usually auto-deployed to all managed nodes):

EXSPI General Data Collection

EXSPI Information Store

EXSPI Message Transfer Agent

EXSPI  Services and Processes
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Add-Ons policy group (only deploy if component is installed):

EXSPI Chat Service (Exchange 2000 only)

EXSPI Conferencing Service (Exchange 2000 only)

EXSPI Instant Messaging (Exchange 2000 only)

EXSPI Site Replication Service

EXSPI Transaction Log

Advanced policy group:

EXSPI End-to-End Message Ping

EXSPI Reporter Collection 
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Deploying policies

To deploy policies manually:

1 Locate the desired policies in the Exchange 5.5 or Exchange 2000 and 
2003 folder.

Figure 51 Location of Exchange SPI General Data Collection policies 
for Exchange 2000 and 2003  

2 Select in the details pane all the policies to be deployed. 
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3 Right click, select All Tasks > Deploy on....

4 Select the nodes that the policies should be deployed on. 

5 Confirm the selection by clicking OK.

Configuring and deploying Reporter Collection policies

The Exchange SPI Reporter Collection policies need to be deployed to any 
Exchange server for which you wish reports. 

The following steps are outlined:

• Create Mailboxes.

• For Exchange 5.5: modify the EXSPI Reporter Collection policies to 
include service account user name and password.

• Deploy Reporter Collection policies.

• Enable message tracking.

Figure 52 Exchange 2000/2003 Reporter Collection policies location 

Task 1: Create mailboxes

See the procedure “Create mailboxes” on page 108.
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Task 2: For Exchange 5.5: modify the EXSPI Reporter Collection Policies to include 
the service account user name and password

For Exchange 5.5 servers: you need to edit each of the EXSPI Reporter 
Collection policies in the EXSPI Advanced policy group by adding the service 
account user name and password, so that Exchange server system data is 
accessible. The EXSPI General Data Collector policies in the EXSPI Quick 
Start policy group do not need modification.

To edit Exchange 5.5 Reporter Collection policies:

1 Open the OVO console and expand the Policy Management folder.

2 In the left pane select Policy groups > SPI for Exchange > Exchange 
5.5 >EXSPI Advanced > EXSPI Reporter Collection policy group.

3 In the right pane right-click a Reporter Collection policy and select All 
Tasks > Edit.

4 In the dialog that appears, check the As User radio button, enter the 
name of the service account, check Specify Password and enter the 
service account password. See “Service account with special Exchange 
privileges” on page 47.

5 Click Save and Close.

6 Repeat these steps for each Reporter Collection policy in the group.

Task 3: Deploy Reporter Collection policies

1 In the OVO Manager console expand the Policy management > Policy 
groups folders to view policy groups.

2 Open SPI for Exchange > Exchange 5.5 or Exchange 2000 and 2003 
> EXSPI Advanced to view the policy groups in the EXSPI Advanced 
folder.

3 In the EXSPI Advanced folder double-click the Reporter Collection 
policy sub-group and see the individual policies in the details pane. 

4 Select the Dc-Exchange Info policy, right-click and select All Tasks > 
Deploy on, check all the nodes and click OK. 

5 Other Reporter policies are deployed to servers depending on whether 
they host mailboxes or public folders. To check this on Exchange 2000 or 
Exchange 2003, run the Exchange System Manager, root to the Server 
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level and look in each storage group to determine if there is any mailbox or 
public store located there. If there are any of either, then the appropriate 
policies need to be deployed to that server in the following steps. 

6 For servers which host mailboxes, select the Dc-TrackLog Data, 
Dc-Mailbox IS Sum Data (for Exchange 5.5 Dc-Private IS Sum Data) 
and Dc-Mailbox Data policies in the details pane, right-click and select 
All Tasks > Deploy on, then select all the servers which host mailboxes 
and click OK. 

7 For servers which host public folders, select the Dc-Public Folder Data 
and Dc-Public IS Sum Data policies in the details pane, right-click and 
select All Tasks > Deploy on, then select all the servers which host 
public folders and click OK.

Task 4: Enabling message tracking 

Exchange provides a message-tracking facility that stores processed message 
information in a log file. This information, which includes sender address, 
recipient addresses, and message size, is collected by the EXSPI-6.0/5.5 
Dc-TrackLog Data collection policy. This policy must be deployed to all 
appropriate managed nodes. 

Before deploying EXSPI 6.0/5.5 Dc-TrackLog Data collection policy you need 
to enable message tracking on your Exchange servers.

Enabling message tracking on Exchange 5.5 Servers

1 Select Start > Programs > Microsoft Exchange > Microsoft 
Exchange Administrator.

2 Expand the site level and Configuration to view selections beneath it.

3 In the details pane double-click Information Store Site Configuration.

4 In the Information Store Site Configuration Properties dialog, check 
Enable message tracking, and select OK.
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Figure 53 Information Store Site Configuration dialog   

5 Repeat steps 3 and 4 for MTA Site Configuration.
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Figure 54 MTA Site Configuration dialog     

6 In the left pane select Connections.

7 In the right pane select Internet Mail Service, check the Enable 
message tracking checkbox, and press OK.

Enabling message tracking on Exchange 2000 or Exchange 2003 servers

1 In the OVO Manager console expand the Tools > SPI for Exchange > 
Exchange 2000 and 2003 folder.

2 In the details pane on the right, double-click the Enable Message 
Tracking tool.

3 Select the servers the tool should launch on.

4 Select Launch to start the tool running on the selected nodes.

5 Enter the user name and password of an Exchange administrator.

If the Internet Mail Service connector does not exist, skip the following steps.
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Time Interval before generation of reports and graphs

Exchange SPI reports and graphs will not be available until data has been 
gathered to the management server from the managed nodes. This occurs 
each night, so at least one day of activity is needed for the reports/graphs to 
populate. Where a report/graph type requires data from a Sat/Sun collection, 
those reports/graphs will require a weekend to pass.

Exchange SPI graphs

Exchange SPI comes with a set of preconfigured graphs. They are located on 
the OVO console tree in the Operations Manager > Reports and Graphs > 
Graphs folders. 

Exchange 2000/2003 graphs

The Exchange 2000/2003 graphs are organized in the following categories:

Directory Service Access

DSAccess Cache Hit-Miss Ratio: This graph shows MSExchangeDSAccess 
cache hit and miss ratio for Exchange 2000 and 2003 servers.

Site Replication Service Space Free: This graph shows the percentage of 
free space on the Site Replication Service volume.

Site Replication Service Space Used: This graph shows Site Replication 
Service space usage on the Exchange server

Information Store 

Users: This graph shows information store user count metrics, for the current 
day.

The Transaction Log Statistics report takes 2 days to process.
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Information Store RPC Performance: This graph shows metrics of 
information store RPC requests and RPC operations rate (operations/sec). 

Figure 55 Example Information Store RPC Performance graph

Transaction Log Space Free: This graph shows the percentage of free space 
on the transaction log volumes. 
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Transaction Log Space Used: This graph shows Exchange server 
transaction log space usage on the Exchange server. 

Delivery: This graph shows hourly metrics for the average delivery times of 
messages to Exchange server private and public mailboxes.

Messaging

Queues: This graph show Exchange server queue lengths. 

MTA Volume: This graph shows Exchange server Message Transfer Agent 
volume.

SMTP Volume: This graph shows SMTP Volume on the Exchange server (for 
Exchange 2000/2003 only). 

SMTP Queues: This graph shows SMTP Server queues on the Exchange 
server (for Exchange 2000/2003 only).

Mailbox Database

Mailbox Database Statistics: This graph shows Exchange server private 
mailbox store database statistics.

Mailbox Streaming Database Statistics: This graph shows Exchange 
mailbox store streaming database statistics.

Private Mailbox Volume: This graph shows Exchange server Private 
Mailbox volume.

Mailbox Usage: This graph shows Exchange server Mailbox usage.
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Public Folder Database

Public Folder Database Statistics: This graph shows Exchange server 
Public Folder store database statistics. 

Public Folder Streaming Database Statistics: This graph shows 
Exchange Public Folder store streaming database statistics.

Figure 56 Example Public Folder Streaming Database Stats graph
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Public Folder Usage: This graph shows Exchange server Public Folder 
usage.

Public Folder Volume: This graph shows Exchange server Public Folder 
volume.

Exchange 5.5 graphs

The Exchange 5.5 graphs are organized in the following categories:

Information Store 

Delivery: This graph shows hourly metrics for the average delivery times of 
messages to Exchange server private and public mailboxes.

Users: This graph shows information store user count metrics, for the current 
day.

Mailbox Database

Mailbox Usage: This graph shows Exchange server mailbox usage.

Private Mailbox Volume: This graph shows Exchange server private 
mailbox volume.

Messaging

Internet Mail Queue: This graph shows the Exchange server Internet Mail 
Service queue count. 

Internet Mail Volume: This graph shows Exchange server Internet Mail 
Connector volume. 

MTA Volume: This graph shows Exchange server Message Transfer Agent 
volume. 

Newsfeed Volume: This graph shows Exchange server newsfeed volume. 

Queues: This graph shows Exchange server queue lengths. 

Public Folder Database

Public Folder Usage: This graph shows Exchange server public folder 
usage.

Public Folder Database: This graph shows Exchange server public folder 
volume.
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Displaying a graph

1 In the console tree, open the folder Reports and Graphs > Graphs > 
SPI for Exchange 2000/2003 or SPI for Exchange 5.5.

2 Select a category of graph on the console tree, then select a graph from the 
list in the details pane and double click. 

3 In the Display graph dialog, select desired Exchange servers from the 
Nodes display, and the date range you wish for the graph. Check the box if 
you wish the data for the graph to be periodically updated.

4 Click Finish and the graph displays.

To enable data collection for these graphs, corresponding data collection 
policies in the Quick Start, Add-Ons, and Advanced policy groups need to be 
deployed. 
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Configuring Exchange SPI 
End-to-End Message Ping

This chapter outlines procedures for: 

• Configuring and deploying End-to-End Message Ping to determine SLA 
performance for Exchange 5.5 servers

• Configuring and deploying End-to-End Message Ping to determine SLA 
performance for Exchange 2000 and Exchange 2003 servers
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Exchange 5.5: configuring and deploying 
End-to-End Message Ping

Use the EXSPI-End-to End Message Ping policy in the Exchange 5.5 EXSPI 
Advanced policy group, to determine SLA performance by sending and 
receiving messages.

The procedure to configure and deploy the EXSPI End-to-End Message Ping 
involves the following tasks:

1 Create a service account with special admin privileges, see “Creating a 
service account for Exchange 5.5 servers” on page 49.

2 Create a mailbox for the service account on every targeted Exchange 
server.

3 Set up the server connections to test message delivery and receipt.

4 Set up the Exchange SPI Message Ping alarms by configuring server pair 
thresholds.

5 Modify the EXSPI End-to-End Message Ping policy to include the service 
account user password.

6 Deploy the Configuration file and the EXSPI End-to-End Message Ping 
policy.

Task 1: Create a service account with special admin privileges

See “Creating a service account for Exchange 5.5 servers” on page 49.

Task 2: Create mailboxes

The service account needs a mailbox on every targeted Exchange server to 
access Exchange mailbox and folder information. 

To create a mailbox for the service account

1 In the OVO Manager console expand the Tools > SPI for Exchange > 
Exchange 5.5 folder.

2 In the details pane on the right, double-click the MBOX Config tool.

3 Select the servers the tool should launch on.

4 Select Launch to start the tool running on the selected nodes.
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5 When prompted, enter the service account user name and password.   

  

If you cannot automatically create mailboxes and receive an error, try to 
manually create a mailbox for each Exchange server with the prefix MSXSPI 
and NT hostname. For example, the node rosspidb5.rose.hp.com (Internet 
name) and NT name ROSSPIB5 require a mailbox called 
MSXSPIROSSPIDB5 with primary NT account MSXSPI.  
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Task 3: Set Up server connections to test message delivery/receipt 

The EXSPI-5.5- Ping Config policy in the EXSPI Advanced group tracks the 
round trip time of a message. Before deploying the policy, the servers you want 
to monitor must be added to this policy.

1 Open the policy Ping Config. 

2 Edit the text in the policy with your Exchange environment information. 
Only one policy is needed since you are able to designate at this level 
which server the configuration line is valid for. When finished, select Save 
and Close.   

Examples:

#     EXCH1::::MSXSPIEXCH2:25m:1m:1m 
#     EXCH1:MSXSPIEXCH1:::MSXSPIEXCH3:2h:5m:2m 
#     EXCH2:MSXSPIEXCH2:::MSXSPIEXCH4:1h:20m:10m 
#     EXCH3:MSXSPIEXCH3:::MSXSPIEXCH4:25m:5m:5m 

EXAMPLE:

Enter server information to replace each entry separated by a colon (:). Each 
uncommented line represents a Service Level Agreement configuration. 

# Format of the file:
# Src-Svr:Src-MB:::Dest-MB:Timeout:MetSLA:AlmostMetSLA 

# Src-Svr = Source Server (required) 

# Src-MB = Source Mailbox (optional)
Defaults to 'MSXSPI<host_name>'. 

# Reserved = Reserved for future use, leave empty 

# Reserved = Reserved for future use, leave empty 

# Dest-MB = Destination Mailbox (required) 

# Timeout = Timeout (required)
 (s-seconds, m-minutes, h-hours) 

# MetSLA = Met SLA time (require for reports)
 (s-seconds, m-minutes, h-hours) 

# AlmostMetSLA = Almost met SLA time (require for reports) 
(s-seconds, m-minutes, h-hours) 
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In the following example of Ping Config policy text: ServerA will use Mailbox 
"MSXSPIServerA" to send a message to mailbox MSXSPIServerB. Server A 
will ignore the information in the line that starts with ServerC. There should 
be no white spaces at the beginning of lines. Lines beginning with # are 
comments and are ignored:

ServerA:MSXSPIServerA:::MSXSPIServerB:2h:5m:2m

ServerC::::MSXSPIServerA:20h:1m:1m  

# End File # __________#   

Definitions of terms:

— Source Server (required) — The server that the ping originates 
from. Each server where Exchange SPI is distributed has the same 
file, so Exchange SPI can parse this file and use all lines where the 
Source Server matches the server where it is run from.

— Source Mailbox (optional) — The mailbox to send the mail from. If 
this is not included, a default account is used “MSXSPI<host_name>” 
where <host_name> is replaced with the name of the server.

— Destination Mailbox (required) — The mailbox to send the ping to. 
This field is usually the only required destination entry.

— Timeout (required) (s-seconds, m-minutes, h-hours) — If a sent 
message does not return in the defined timeout interval, EXSPI logs it 
as a failure and sends a message to the OVO management server. 
Failed messages are tallied in terms of count and percentage within a 
report. The timeout value must be larger than the values for MetSLA 
and AlmostMetSLA so that a returned message can be processed 
using these values. It may have Exceeded SLA even though it has not 
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exceeded the timeout interval. A Failed/Timedout message occurs, 
therefore, only when the message does not return before the timeout 
period is exceeded.  

— MetSLA (required for reports) (s-seconds, m-minutes, h-hours) — If 
the round trip time is greater than this value, the message is logged as 
either Almost Met SLA or Exceeded SLA. This value is required if 
data is being sent to the Measurement Data Collector Agent DSI for 
reporting (-l option when running exspi.exe). It is optional if only 
using alarms.

— AlmostMetSLA (required for reports) (s-seconds, m-minutes, 
h-hours)  — If the round trip time is greater than the MetSLA value 
but less than or equal to MetSLA plus AlmostMetSLA, the message is 
logged as Almost Met SLA. Otherwise, when the round trip time is 
higher than MetSLA plus AlmostMetSLA, it is logged as Clearly 
Exceeded SLA. This parameter is required if data is being logged to 
the data collection Agent DSI (-l option when running exspi.exe), 
optional if only using alarms.   

The minimum timeout value should be set slightly less than the 
collection interval. For example, if the collection interval for metric 
1002 is 30 minutes (the default), the timeout should be set to at 
least 25 minutes. The logic is that because the next measurement 
occurs only every 30 minutes, you should allow up to that amount 
of time for any messages to return before “giving up” and 
generating a failure. If you keep the timeout value within the 
collection interval and the reply message does return, it can be 
processed as Met, Almost Met, or Exceeded as opposed to Failed/
Timedout. 

Timeout, MetSLA, and AlmostMetSLA values can have optional 
identifiers that denote the measurement units the value 
represents; for example, 4m (4 minutes) 30s (30 seconds) or 1h (1 
hour). The default unit is seconds; for example, the entry 4 by 
default is recognized as 4 seconds. 
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2 

C

C

Examples:

EXCH1::::MSXSPIEXCH2:25m:1m:1m
Use the default FROM mailbox of MSXSPIEXCH1. Message must return 
within 1 minute to meet the SLA, 2 minutes to almost meet the SLA, and 
at over 25 minutes a failure/timeout is generated.

EXCH1:MAILBOXEXCH1:::MAILOXEXCH3:2h:5m:2m 
Message must return within 5 minutes to meet the SLA, 7 minutes to 
almost meet the SLA, and at over 2 hours a failure/timeout is generated.

EXCH2:MAILBOXEXCH2:::MAILOXEXCH4:1h:20m:10m
Message must return within 20 minutes to meet the SLA, 30 minutes to 
almost meet the SLA and at over 1 hour a failure/timeout is generated.

Task 4: Set Up EXSPI End-to-End Message Ping Alarms—configure server pair 
thresholds 

Alarms can be set to occur with metric 1002 (Ping). As you may need to set 
different thresholds for multiple server pairs, some examples are included 
here to clarify the procedure. These examples show the syntax to insert in the 
exspilnk.txt file to set differing thresholds. Metric 1002 sends the 
“FromMailbox,ToMailbox” in the object pattern fields with the following 
definitions:

FromMailbox = FromServer:FromMailbox

ToMailbox    = :ToMailboxl   

Requirement: When you configure server connections, you must start the 
EXSPI Admin tool EXSPI Ping Config from the OpenView management 
server. 

Config Entry Object 

EXCH1::::MSXSPIEXCH2:25m:1m:1m EXCH1:MSXSPIEXCH1,:MSXSPIEXCH

EXCH1:MAILBOXEXCH1:::

MAILOXEXCH3:2h:5m:2m 

EXCH1:MAILBOXEXCH1,:MAILOXEX
H3 

EXCH2:MAILBOXEXCH2:::

MAILOXEXCH4:1h:20m:10m 

EXCH2:MAILBOXEXCH2,:MAILOXEX
H4 
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Task 5: Modify the policy to include the service account password

Before deploying the EXSPI End-to-End Message Ping policy, you must edit it 
to include the service account name and password, so that it has access to data 
on the Exchange server system. 

To edit the policy:

1 Open the OVO console and expand the Policy Management folder.

2 In the left pane select Policy groups > SPI for Exchange > Exchange 
5.5 > EXSPI Advanced > EXSPI End-to-End Message Ping group.

3 In the right pane right-click the EXSPI-5.5-End-to-End Message Ping 
policy and select All Tasks > Edit.

Condition Name & 
Type

Condition Object 
Pattern Threshold Explanation

EXSPI-1002.1
+Message on
Matched Condition

EXCH1:MSXSPIEXCH1, 
:MSXSPIEXCH2

120 Threshold condition for ping 
between System EXCH1 and 
mailbox MSXSPIEXCH2 on 
system EXCH2. Object 
pattern is case sensitive.

EXSPI-1002.2
+Message on 
Matched Condition

EXCH1:MSXSPIEXCH1, 
:MSXSPIEXCH3

240 Threshold condition for ping 
between System EXCH1 and 
mailbox MSXSPIEXCH3 on 
system EXCH3. Object 
pattern is case sensitive.

EXSPI-1002.3
-Suppress 
Matched Condition

EXCH1:MSXSPIEXCH1, 
:MSXSPIEXCH2
EXCH1:MSXSPIEXCH1, 
:MSXSPIEXCH3

If the threshold was not 
exceeded for these two 
system pairs, you must 
suppress the message if 
either of these system pairs 
gets past 1002.1 or 1002.2.

EXSPI-1002.4
+Message on 
Matched Condition

60 A blank object pattern to 
catch all remaining system 
pairs.
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4 In the dialog that appears, confirm or enter the service account user name 
(MSXSPI), check the Specify Password check box, and enter the 
password you assigned to the service account.

5 Click Save and Close.

Task 6: Deploy the configuration file and the policy

1 In the OVO Manager console expand the folders Policy management > 
Policy groups > SPI for Exchange > Exchange 5.5 > EXSPI 
Advanced.

2 In the EXSPI Advanced folder double-click the Advanced policy 
sub-group you want to deploy. 

3 In the details pane where all the policies and/or configuration files are 
now listed, select the policies and/or configuration file needed, right-click, 
and select Deploy on....

4 In the Deploy policies on... dialog, select all nodes by clicking the check 
box next to Nodes, or select individual nodes by clicking the adjacent 
checkbox.
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Format of objects passed from the Exspi executable to the Metric 
1002 for End-to-End Message Ping

The executable exspi_e55.exe is used to pass objects to the monitoring 
Measurement Threshold Policy EXSPI-5.5-1002. This monitor evaluates the 
End-to-End Message Ping and is used to check if the Service Level 
Agreements (SLA) for the turnaround-time of a mail time are met. The 
executable passes a message back to the "Measurement Threshold" Policy to 
match on the Object name in the following format:

A:B:C:D:E:F 

The format has the following meaning:

– A is one of the strings: 
["SLAViolation"|"SLAWarning"|"Timeout"|"Undeliverable"].

– B is Source node.

– C is Source Mailbox.

– D is Destination Node.

– E is Destination Mailbox.

– F is one of the following, depending on A: [SLA Threshold|Warning 
Threshold|Timeout Threshold].

According to this format, the default policy has four rules that match on the 
Object A. According to the value of A, a message is created and sent to the 
OVO Message Browser.
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Comparison: End-to-End Message Ping for 
Exchange 5.5 v. Exchange 2000/2003

— The Exchange SPI End-to-End Message Ping for Exchange 2000 and 
Exchange 2003 sends the ping message to the System Assistant 
account of a destination Exchange 2000/2003 server. Therefore, there 
is no need to configure a receiving mailbox. 

— In addition, the ping messages received by the System Assistant will 
be automatically deleted by the Exchange 2000/2003 server and do not 
need to be manually deleted from the receiving mailbox by the 
Exchange SPI user.
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Exchange 2000/2003: configuring and deploying 
End-to-End Message Ping

The EXSPI End-to-End Message Ping procedure requires the following steps:

• Create/specify a mailbox for each source Exchange 2000/2003 server 
where the policy will be deployed.

• Run the Exchange SPI End-to End Configuration wizard to create Service 
Level Agreement configurations for all managed Exchange 2000/2003 
servers.

Task 1: Create a new source mailbox for each source server

A mailbox needs to be created on each OVO managed Exchange 2000 or 
Exchange 2003 server from which the Ping messages will be sent out

1 In the OVO manager console, expand the Tools > SPI for Exchange > 
Exchange 2000 and 2003 folder.

2 In the details pane on the right, double click the MBOX Config tool

3 Select the servers the tool should launch on.

4 Launch the MBOX Configuration tool on the managed Exchange server to 
create a new user and associated mailbox with a prefix ID. 

5 If you want to specify the organizational unit and mailbox prefix:

a Select the Parameters tab  By default the organizational unit is set 
to “Users”, and the default mailbox prefix ID is msxspi, so the user/
mailbox name will be msxspi<server name>. 

b Create the mailbox name with a prefix ID, followed by the Windows 
hostname, with no spaces: <prefix ID><server name>, e.g. 
msxspi<server name>

c Select the Login tab. Enter the User name and password for a user 
who has the privilege to create mailboxes in this domain.

d Click Launch.
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Task 2: Run the End-to-End Configuration wizard to configure SLAs

1 In the OVO Manager console expand the Tools > SPI for Exchange > 
Exchange 2000 and 2003 folder.

2 In the details pane on the right, double-click the End-to-End 
Configuration tool.

3 Confirm the introductory dialog, which gives an example of a typical SLA, 
by clicking Next.

4 Select the Exchange SPI configuration setting that best matches your 
SLA. Click Next.

5 Select the Source Servers from the list of OVO managed servers. A source 
server is a server from which email is sent, which is the server from which 
the SLA is determined. Click Next.

6 Select the Destination Servers from the list. These can be any Exchange 
servers within your organization, not only OVO managed Exchange 
servers. Click Next.

7 Specify the Service Level Agreement by assigning the thresholds (in 
seconds) for Timeout, Met SLA and Almost met SLA. 

Figure 57 Example SLA thresholds

Before running the End-to-End Configuration wizard, it is necessary to 
remove any End-to-End Message Ping policies previously deployed to servers. 
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8 Click Next.

9 Confirm or make changes to the SLAs. Click Next.

10 Select to deploy all End-to-End Policies to the managed nodes. Only 
managed nodes configured to determine SLAs will send and receive mail. 
Note: This step can also be performed manually by deploying SPI for 
Exchange 2000/2003 instrumentation and the EXSPI End-to-End 
Message Ping policy group to any desired managed nodes. 

11 Click Next.

12 Click Finish. Then OK.

The wizard will have to be run whenever an Exchange server becomes an 
OVO managed server, if an SLA is required on the newly managed server.
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Customizing policies and uninstalling 
the Exchange SPI

This chapter outlines the procedures for:

• Customizing policies and groups of policies

• Uninstalling the Exchange SPI

Customizing policies using the tag feature

If you have servers dedicated to specific sites or business units, you may find it 
effective for those servers to have uniquely named Exchange SPI policies. In 
such cases copy default policies into new groups, affix prefixes to the original 
names and include them in the schedule policy that collects data during that 
measurement interval. The procedure below gives you an example of how you 
might do this.

Task 1: Create the new policy group 

1 In the OVO console, expand the Policy management > Policy Groups 
folders.

2 Right-click the folder in which you want to locate the new group and select 
New > Policy Group.
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Customizing policies using the tag feature
Figure 58 Creating a new policy group 

3 Enter the new group name for the folder created and click Enter.

4 In the console, use Shift+click or Ctrl+click to select the default policies to 
be in the group, right-click and select Copy.  

Remember to always copy scheduled task policies from the default 
policy group containing the measurement threshold policy you are 
copying to the new policy group. The scheduled task policy is 
necessary for any data collection to occur. 
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5 Right-click the new group you just created and click Paste.

6 The copied policy will be pasted into the new Policy group.

7 If you copied an entire group of default policies into the new group, you 
can eliminate those you do not need by right-clicking them and selecting 
Delete.

Task 2: Tag the policies

To designate these policies as a specific group, use a special prefix

1 Double-click each policy and make any changes to the policy desired. 

2 Select File > Save As. In the dialog that appears enter the special prefix 
followed by a hyphen in front of the default policy name; for example 
EuroSales-EXSPI-6.0 IS Mailbox Average Delivery Time.
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Figure 59 Customizing a policy 

3 After saving any renamed policies, double-click the scheduled task policy 
that you copied to the new group together with the other policies. (In the 
example EXSPI-6.0 Id-Dc-Instant Messaging is used.)

4 In the Command* text box at the end of the text, insert the tag (-t) 
parameter and the <prefix>- 
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For example, to ensure data collection for all the policies renamed with the 
prefix EuroSales the Command text box would appear as shown in the 
figure below: 

Figure 60 Example of an edited Command 

5 When finished, rename the scheduled task policy to include the group 
prefix, in this way: 

Select File > Save As and rename the EXSPI-6.0 Id-Dc-Instant 
Messaging scheduled task policy to EuroSales-EXSPI-6.0 Id-Dc-Instant 
Messaging.
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Figure 61 Renaming policy 

The prefix attached to the beginning of each policy in the new group makes 
the policies easy to find in the Policies grouped by type folder in the 
console. Also, creating a new group for the new policies gives you an efficient 
means to deploy them (right-click the group and select All Tasks > Deploy 
on...). Please see the online Help for more details.
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Uninstalling Exchange SPI

You may wish to remove the Exchange SPI from an OVO managed node, or 
uninstall the Exchange SPI from both the management server and the 
managed node/s. In both cases the first step is to remove Exchange SPI 
policies from managed node/s. 

1 Remove Exchange SPI policies from managed node/s

For the more complete uninstall, removing the Exchange SPI from both the 
management server and the managed node/s, follow these additional steps:

2 Delete Exchange SPI policy groups from management server.

3 Delete Exchange SPI tools from management server.

4 Uninstall Exchange SPI programs from the management server

For any uninstall of Exchange SPI:

Task 1: Remove Exchange SPI policies from all managed nodes

1 On the OVO console tree, expand the folders HP OpenView > 
Operations Manager > Policy Management > Policy groups > SPI 
for Exchange.

2 Right-click the SPI for Exchange, select All Tasks > Uninstall from...

3 In the “Uninstall Policies on” dialog, select All Nodes.

4 Click OK.

Uninstalling Exchange SPI from the management server:

Task 2: Delete Exchange SPI policy groups from the management server

1 On the OVO console tree select and expand the folder Policy Groups.

2 Right-click SPI for Exchange and select Delete.

Note: If there are any customized policies on the node/s, remove them from 
their location.
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Task 3: Delete Exchange SPI tools from the management server

1 On the OVO console tree right-click Tools and select Configure > Tools.

2 In the “Configure Tools” dialog right-click SPI for Exchange and select 
Delete.

Task 4: Uninstall Exchange SPI programs from the management server

1 Insert the HP OpenView Operations/Performance for Windows CD (Disk 
1) into the CD-ROM drive.

2 Follow instructions as they appear. Start the uninstall procedure by 
selecting the Remove products radio button. 

3 In the Product Selection Uninstall window select Microsoft 
Exchange Server (SPI) and click Next.

4 In the next window, select Remove. (You are updated on the progress of 
the program removal).

5 Click Finish to complete the uninstall.
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Exchange SPI Instrumentation Files

EXSPI Exchange Discovery Instrumentation

Exchange 2000/2003 EXSPI Instrumentation

EXSPI_CreateServices.js Discovers hosted on Services

msexchange.apm.xml Cluster support file

OvExchDisc.exe Discovers virtual Services

exspi_e2k.exe Collector used through schedules

exspidatasource.exe Creates database schema

EXSPI*.spec Database schema definitions

ovamd*.dll Tracking log collector libraries

hpudm.txt Metric definitions

exspitra.vbs Turn Tracking on and off

exspi_tracklog.vbs Turn Tracking log file generation on

exspi_e2k_cfg Create mailbox.vbs

exspi_dbmount.vbs Check, or mount, dismounted 
Information Store

exspi_StartService.vbs Starts a service
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end-to-end.xml End-to-End Config file

exspi_e2k_clust_config.js For Cluster Configuration

exspi_RunDiscovery.js For Exchange SPI Auto Discovery

exspi_e55.exe Collector used through schedules

exspidatasource.exe Creates database schema

EXSPI*.spec Database schema definitions

ovamd*.dll Tracking log collector libraries

hpudm.txt Metric definitions

exspitra.vbs Turn Tracking on and off

exspi_e55_cfg.exe Create mailbox
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Policy mappings: metric number to 
policy name

 

Metric 
ID OVO Windows OVO UNIX

1 EXSPI-5.5 Process Monitor
EXSPI-6.0 Process Monitor

EXSPI-0001, EXSPI-05m-Services 
and Processes

2 EXSPI-5.5 Inactive Process Monitor
EXSPI-6.0 Inactive Process Monitor

EXSPI-0002, EXSPI-10m-Services 
and Processes

5 EXSPI-5.5-0005, EXSPI-6.0-0005 EXSPI-0005

6 EXSPI-5.5-0006, EXSPI-6.0-0006 EXSPI-0006

10 EXSPI-5.5 MTA Message Delay
EXSPI-6.0 MTA Message Delay

EXSPI-0010, EXSPI-05m-MTA

11 EXSPI-5.5 MTA Work Queue Length
EXSPI-6.0 MTA Work Queue Length

EXSPI-0011, EXSPI-05m-MTA

12 EXSPI-5.5 MTA Failed Conversions
EXSPI-6.0 MTA Failed Conversions

EXSPI-0012, EXSPI-1h-MTA
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13 EXSPI-5.5 MTA Connection Message Delay
EXSPI-6.0 MTA Connection Message Delay

EXSPI-0013, EXSPI-05m-MTA

14 EXSPI-5.5 MTA Connection Queue Lengths
EXSPI-6.0 MTA Connection Queue Lengths

EXSPI-0014, EXSPI-05m-MTA

15 EXSPI-5.5 MTA Failed Outbound 
Associations
EXSPI-6.0 MTA Failed Outbound 
Associations

EXSPI-0015, EXSPI-1h-MTA

16 EXSPI-5.5 MTA Rejected Inbound 
Associations
EXSPI-6.0 MTA Rejected Inbound 
Associations

EXSPI-0016, EXSPI-1h-MTA

17 EXSPI-5.5 MTA Rejected Inbound Messages
EXSPI-6.0 MTA Rejected Inbound Messages

EXSPI-0017, EXSPI-1h-MTA

30 EXSPI-5.5 IS Public Average Delivery Time
EXSPI-6.0 IS Public Average Delivery Time

EXSPI-0030, EXSPI-05m-IS

31 EXSPI-5.5 IS Public Average Local Delivery 
Time
EXSPI-6.0 IS Public Average Local Delivery 
Time

EXSPI-0031, EXSPI-05m-IS

32 EXSPI-5.5 IS Public Replication Queue 
Length
EXSPI-6.0 IS Public Replication Queue 
Length

EXSPI-0032, EXSPI-05m-IS

33 EXSPI-5.5 IS Public Receive Queue Length
EXSPI-6.0 IS Public Receive Queue Length

EXSPI-0033, EXSPI-05m-IS

34 EXSPI-5.5 IS Public Send Queue Length
EXSPI-6.0 IS Public Send Queue Length

EXSPI-0034, EXSPI-05m-IS

Metric 
ID OVO Windows OVO UNIX
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40 EXSPI-5.5 IS Private Average Delivery 
Time
EXSPI-6.0 IS Mailbox Average Delivery 
Time

EXSPI-0040, EXSPI-05m-IS

41 EXSPI-5.5 IS Private Average Local 
Delivery Time
EXSPI-6.0 IS Mailbox Average Local 
Delivery Time

EXSPI-0041, EXSPI-05m-IS

42 EXSPI-5.5 IS Private Receive Queue Length
EXSPI-6.0 IS Mailbox Receive Queue 
Length

EXSPI-0042, EXSPI-05m-IS

43 EXSPI-5.5 IS Private Send Queue Length
EXSPI-6.0 IS Mailbox Send Queue Length

EXSPI-0043, EXSPI-05m-IS

50 EXSPI-6.0 SMTP Categorizer Queue 
Length

EXSPI-0050, EXSPI-5m-SMTP

51 EXSPI-6.0 SMTP Local Queue Length EXSPI-0051, EXSPI-5m-SMTP

52 EXSPI-6.0 SMTP Local Retry Queue Length EXSPI-0052, EXSPI-5m-SMTP

53 EXSPI-6.0 SMTP Messages Pending 
Routing

EXSPI-0053, EXSPI-5m-SMTP

54 EXSPI-6.0 SMTP Remote Queue Length EXSPI-0054, EXSPI-5m-SMTP

55 EXSPI-6.0 SMTP Remote Retry Queue 
Length

EXSPI-0055, EXSPI-5m-SMTP

56 EXSPI-6.0 SMTP NDR Percentage EXSPI-0056, EXSPI-1h-SMTP

57 EXSPI-6.0 SMTP Outbound Connections 
Refused

EXSPI-0057, EXSPI-1h-SMTP

58 EXSPI-6.0-0058 EXSPI-0058

60 EXSPI-5.5 IMS Failed Connections EXSPI-0060, EXSPI-1h-Internet 
Mail Services

Metric 
ID OVO Windows OVO UNIX
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61 EXSPI-5.5 IMS Rejected Connections EXSPI-0061, EXSPI-1h-Internet 
Mail Services

62 EXSPI-5.5 IMS MTS-IN Queue Length EXSPI-0062, EXSPI-5m-Internet 
Mail Services

63 EXSPI-5.5 IMS MTS-OUT Queue Length EXSPI-0063, EXSPI-5m-Internet 
Mail Services

64 EXSPI-5.5 IMS Queued Inbound EXSPI-0064, EXSPI-5m-Internet 
Mail Services

65 EXSPI-5.5 IMS Queued Outbound EXSPI-0065, EXSPI-5m-Internet 
Mail Services

66 EXSPI-5.5 IMS NDRs Inbound EXSPI-0066, EXSPI-1h-Internet 
Mail Services

67 EXSPI-5.5 IMS NDRs Outbound EXSPI-0067, EXSPI-1h-Internet 
Mail Services

80 EXSPI-5.5-0080, EXSPI-6.0-0080 EXSPI-0080

81 EXSPI-5.5-0081, EXSPI-6.0-0081 EXSPI-0081

90 EXSPI-5.5-0090, EXSPI-6.0-0090 EXSPI-0090

91 EXSPI-5.5-0091, EXSPI-6.0-0091 EXSPI-0091

92 EXSPI-5.5-0092, EXSPI-6.0-0092 EXSPI-0092

93 EXSPI-5.5-0093, EXSPI-6.0-0093 EXSPI-0093

94 EXSPI-5.5-0094, EXSPI-6.0-0094 EXSPI-0094

95 EXSPI-5.5-0095, EXSPI-6.0-0095 EXSPI-0095

96 EXSPI-5.5-0096, EXSPI-6.0-0096 EXSPI-0096

97 EXSPI-5.5-0097, EXSPI-6.0-0097 EXSPI-0097

100 EXSPI-5.5 IS User Connection Count Low
EXSPI-6.0 IS User Connection Count Low

EXSPI-0100, EXSPI-15m-IS

Metric 
ID OVO Windows OVO UNIX
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100 EXSPI-5.5 IS User Connection Count Low
EXSPI-6.0 IS User Connection Count Low

EXSPI-0100, EXSPI-15m-IS

110 EXSPI-5.5 DS Pending Synchronizations EXSPI-0110, EXSPI-05m-DS

111 EXSPI-5.5 DS Remaining Updates
EXSPI-6.0 SRS Remaining Updates

EXSPI-0111, EXSPI-05m-DS
EXSPI-0111, EXSPI-05m-DS

800 EXSPI-6.0-0800 EXSPI-0800

801 EXSPI-6.0-0801 EXSPI-0801

802 EXSPI-6.0-0802 EXSPI-0802

803 EXSPI-6.0-0803 EXSPI-0803

804 EXSPI-6.0-0804 EXSPI-0804

805 EXSPI-6.0-0805 EXSPI-0805

806 EXSPI-6.0-0806 EXSPI-0806

807 EXSPI-6.0-0807 EXSPI-0807

830 EXSPI-6.0-0830 EXSPI-0830

831 EXSPI-6.0-0831 EXSPI-0831

833 EXSPI-6.0-0833 EXSPI-0833

834 EXSPI-6.0-0834 EXSPI-0834

835 EXSPI-6.0-0835 EXSPI-0835

836 EXSPI-6.0-0836 EXSPI-0836

841 EXSPI-6.0-0841 EXSPI-0841

842 EXSPI-6.0-0842 EXSPI-0842

845 EXSPI-6.0-0845 EXSPI-0845

846 EXSPI-6.0-0846 EXSPI-0846

Metric 
ID OVO Windows OVO UNIX
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NOTE: 

• OVO Windows policies for Exchange version 5.5 have the prefix 
EXSPI-5.5. 

• OVO Windows policies for Exchange versions 2000 and 2003 have the 
prefix EXSPI-6.0. 

1001 EXSPI-5.5 Exchange Services
EXSPI-6.0 Exchange Services

EXSPI-1001, EXSPI-05m-Services 
and Processes, EXSPI-05m-Map

Metric 
ID OVO Windows OVO UNIX
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Appendix C
Creating service accounts for 
Exchange 2000 or 2003

The Exchange SPI collects data from many sources. In order to collect the 
many types of data, the Exchange SPI requires advanced user credentials. 
The simplest way to obtain these credentials is to have the OVO management 
agent run as Local System. If this is not possible in your organization, you'll 
need to create a special service account with the necessary privileges. 

This procedure outlines how to create a service account with advanced user 
credentials for Exchange 2000 or Exchange 2003 nodes.

Task 1: Create service account 

1 Log on to the system that hosts the managed node’s domain.

2 Select Start > Settings > Control Panel > Administrative Tools > 
Active Directory Users and Computers.
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3 Expand the Active Directory Users and Computers and right-click Users 
and select New > User,

4 In the New Object - User dialog, enter a user name for the new service 
account into the First Name and the User logon name fields.  

You must create a service account with these privileges in each Windows domain. You 
may use any user name you wish. Throughout this document we are using MSXSPI as 
the user name for the service account. 
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Figure 62 Entering the new service account name   

5 In the next window, enter Password/Confirm Password for the service 
account.

6 Select Password Never Expires. Then click Next.
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Figure 63 Setting password properties   

7 In the New Object dialog, deselect Create an Exchange mailbox, and 
click Next
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Figure 64 Deselecting creating a mailbox   

8 In the next dialog, complete creating the user by clicking Finish.

9 You are now back at the Active Directory Users and Computers 
dialog. In the right pane, right-click on the service account user just 
created and select Properties.

10 In the service account Properties page, select the General tab. Enter 
OVO Exchange SPI in the Display name and Description fields.
141



Figure 65 Entering names in Properties dialog   

11 Select the Member Of tab, and click Add.

12 In the Select Group dialog select Exchange Domain Servers from the 
top pane. Click Add, then OK.

13 The new user is now a member of Domain Admins group. Click OK and 
exit the Active Directory Users and Computer dialog.
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Figure 66 Confirming membership privileges   

Task 2: Add service account user to Local Administrators group

1 On each targeted Exchange 2000/2003 server, select Start > Settings > 
Control Panel. 

2 Double click Administrative Tools. Double click Computer 
Management, then open the Local Users and Groups folder. Select 
and open the Groups folder, then double click Administrators.
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3 In the Administrators Properties dialog, click the Add button. Select 
the correct Domain from the Look in drop down list. Select the new 
service account user from the list, and click Add.

4 Update the discovery policy EXSPI-6.0 Exchange Service Discovery, to 
include this new user.

5 This procedure needs to be carried out for each targeted Exchange 2000/
2003 server.  

It can sometimes take a few hours for new group membership and 
rights to be applied to a service account. 
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Exchange Cluster terminology

Cluster

A cluster is a group of independent computers, called nodes, that present 
themselves to a network as a highly available single system.

Node

A system that is a member of a cluster, and has a working installation of the 
Cluster Service. 

Resources

Resources are physical or logical entities, such as applications, or services, 
under the control of the Cluster Service.

Cluster Resource Group

A Cluster resource group is a set of resources that are grouped together to be 
managed as a single unit for configuration and recovery purposes. Each 
resource in a resource group may be dependent on other resources within that 
group.

A resource group is the unit of failover in a cluster. 
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Failover

Failover is the process of moving a resource group from one node to another in 
the case of a failure. A failover can occur automatically, in the case of a 
problem, or manually, initiated by an administrator.

Failback

Is the process of returning a resource group to the node on which it was 
running before a failover happened.

Active/passive

A cluster is in Active/Passive mode when one node is active while another is 
passive/idle. Only when the active node fails or is taken offline, will the 
passive node becomes active.

Active/active

Each node is assigned some of the workload and process requests from clients. 
When one node fails or is taken offline, control of its resources are passed to 
the other node.

Virtual Server

A virtual server is a resource group and contains:

• A Network Name resource

• An IP Address resource

• The resources to be accessed by the clients of the virtual server.

A virtual server acts as a standalone system. Clients on the network interact 
with the virtual server just as if it were a physical server.

Exchange Server Cluster 

To create an Exchange Server cluster, services provided by the Windows 
Cluster service are needed. Microsoft Exchange Server installs custom files 
and resources when installing the cluster-aware version of Exchange. This 
cluster-aware version of Exchange is installed when Exchange Server Setup is 
run on a node of a Windows Server cluster.
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Exchange Virtual Server (EVS)

If Exchange is installed in a Windows Cluster; the EVS is the network name 
of a cluster resource group which contains:

• A Network Name resource

• An IP Address resource

• A Disk Resource on a common storage subsystem.

Additional resources represent the various components of Exchange:

— System Attendant

— Information Store

— Routing

— Message Tracking Agent

— MSSearch

— Protocol

— SMTP

— HTTP

— POP3

— IMAP

 The EVS runs as a unit on one node in the cluster at any given time. It may 
also be limited to a subset of the total nodes in the cluster.
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A
access permissions, granting, 55, 57
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C
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D
daily tasks, suggested, 45
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E
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End-to-End Message Ping alarms, 113, 114
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Exchange messaging view, 12
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Exchange service monitor, 10
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MetSLA, 112
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monitoring configuration file, 82
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msexchange.apm.xml, modifying, 81

MTA work queue, 10

N
network connections, testing, 79

O
organizational view, seeing, 18, 22

OVO message browser, 45

P
passwords

modifying policies to include service 
accounts, 114

modifying the EXPSI Reporter 
Collection Policies, 95, 96

policies
Adds-Ons group, deploying, 79
advanced, 79
creating new group, 121, 123
customizing, 121, 126
deploying, 21, 79, 80
displaying, 25
modifying to include service account 

password, 114
receiving reports, 95
setup, 21
tagging, 123, 126

Policies grouped by type folder, 27

Policy groups folder, 26
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procedures
Add-Ons group, deploying policies, 79
mailboxes, creating, 108, 109
message tracking, enabling

5.5 servers, 97, 99
Exchange 2000/2003 servers, 99

Messaging View, seeing, 18, 22
Organizational View, seeing, 18, 22
policies

creating a new group, 121, 123
editing to include service account 

password, 114
tagging, 123, 126

Quick Start policies, deploying manually, 
78

Reporter Collection Policies
editing, 96

Reporter Collection Policies, deploying, 
95, 96

servers, configuring, 113
service accounts

creating (NT), 49, 55
creating in W2k/Ex2000 or 2003, 

137 to 142
creating in W2k/EX5.5, 58, 59
grant access permission in W2k/

EX5.5, 65, 66
granting access permissions, 55, 57

process monitor, 10

Public Average Delivery Time, 10

Q
Quick Start, deploying policy group, 78

R
Reporter Collection Policies

deploying, 95, 96

Reporter Collection policy group, 80

reports
using, 92

S
server-monitoring capabilities, 9

servers, configuring, 113

service accounts
access permissions

granting, 55, 57
creating

NT4/EX5.5, 49, 55
W2k/Ex 2000 or 2003, 142
W2k/Ex2000 or 2003, 137

creating in W2k/EX5.5, 58, 59
grant access permissions

W2k/EX5.5, 65, 66
mailboxes, creating, 108, 109
modifying the EXSPI Report Collection 

Policies to include passwords, 95, 96
password, modifying policy to include, 

114

service level agreements, 107

SLA
for Exchange 2000/2003, 118
for Exchange 5.5, 108

SMTP queues, 10

source mailbox, 111

source server, 111

support costs, lowering, 10

T
tag feature, using, 121

tasks, suggested daily, 45

timeout, 111

tools
removing from management server, 128
using, 28
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Trace On/Trace Off tools, 30

tracing, 28

U
uninstalling, 127
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